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1 About This Guide 
Thank you for purchasing the freeConnect Smart G2400.  This device integrates 1000Mbps Gigabit 
Ethernet, 100Mbps Fast Ethernet and 10Mbps Ethernet network capabilities in a highly flexible 
package. 

1.1 Purpose 
This guide discusses how to install your freeConnect Smart G2400.  

1.2 Terms/Usage 
In this guide, the term “Switch” (first letter upper case) refers to your freeConnect Smart G2400, and 
“switch” (first letter lower case) refers to Ethernet switches in general. 
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2 Introduction 
This chapter describes the features of the freeConnect Smart G2400 and some background 
information about Ethernet/Fast Ethernet/Gigabit Ethernet switching technology. 

2.1 Gigabit Ethernet Technology 
Gigabit Ethernet is an extension of IEEE 802.3 Ethernet utilizing the same packet structure, format, 
and support for CSMA/CD protocol, full duplex, flow control, and management objects, but with a 
tenfold increase in theoretical throughput over 100-Mbps Fast Ethernet and a hundredfold increase 
over 10-Mbps Ethernet. Since it is compatible with all 10-Mbps and 100-Mbps Ethernet environments, 
Gigabit Ethernet provides a straightforward upgrade without wasting a company’s existing investment 
in hardware, software, and trained personnel. 

The increased speed and extra bandwidth offered by Gigabit Ethernet is essential to coping with the 
network bottlenecks that frequently develop as computers and their busses get faster and more users 
use applications that generate more traffic. Upgrading key components, such as your backbone and 
servers to Gigabit Ethernet can greatly improve network response times as well as significantly speed 
up the traffic between your subnets. 

Gigabit Ethernet enables fast optical fiber connections to support video conferencing, complex 
imaging, and similar data-intensive applications. Likewise, since data transfers occur 10 times faster 
than Fast Ethernet, servers outfitted with Gigabit Ethernet NIC’s are able to perform 10 times the 
number of operations in the same amount of time. 

In addition, the phenomenal bandwidth delivered by Gigabit Ethernet is the most cost-effective method 
to take advantage of today’s and tomorrow’s rapidly improving switching and routing internetworking 
technologies. 

2.2 Fast Ethernet Technology 
The growing importance of LANs and the increasing complexity of desktop computing applications are 
fueling the need for high performance networks.  A number of high-speed LAN technologies have 
been proposed to provide greater bandwidth and improve client/server response times. Among them, 
100BASE-T (Fast Ethernet) provides a non-disruptive, smooth evolution from the current 10BASE-T 
technology.  The non-disruptive and smooth evolution nature, and the large installed market base, 
virtually guarantees cost-effective and high performance Fast Ethernet solutions. 

100Mbps Fast Ethernet is a standard specified by the IEEE 802.3 LAN committee. It is an extension of 
the 10Mbps Ethernet standard with the ability to transmit and receive data at 100Mbps, while 
maintaining the CSMA/CD Ethernet protocol. Since the 100Mbps Fast Ethernet is compatible with all 
other 10Mbps Ethernet environments, it provides a straightforward upgrade and takes advantage of 
the existing investment in hardware, software, and personnel training. 

2.3 VLAN (Virtual Local Area Network) 
A VLAN is a group of end-stations that are not constrained by their physical location and can 
communicate as if a common broadcast domain, a LAN.  The primary utility of using VLAN is to 
reduce latency and need for routers, using faster switching instead.  Other VLAN uses include: 

Security: Security is increased with the reduction of opportunity in eavesdropping on a broadcast 
network because data will be switched to only the users within the same VLAN. 
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Cost Reduction: VLANs can be used to create multiple broadcast domains, thus eliminating the need 
of expensive routers. 

Port-based (or port-group) VLAN is the common method of implementing a VLAN, and is the one 
supplied in the Switch. 

2.4 Features 
• 24x10/100/1000Mbps Auto-negotiation Gigabit Ethernet ports 

• All RJ45 ports support auto MDI/MDIX, so there is no need to use cross-over cables or an up-link 
port 

• Half duplex transfer mode for connection speed 10Mbps and 100Mbps 

• Full duplex transfer mode for connection speed of 10Mbps, 100Mbps and 1000Mbsps 

• Wire speed reception and transmission 

• Store-and-Forward switching scheme capability to support rate adaptation and ensure data 
integrity 

• Up to 8k unicast addresses entities per device, self-learning, and table aging 

• 4Mbits packet buffer 

• Supports IEEE 802.3x flow control for full-duplex mode ports 

• Supports Port-base VLAN 

• Supports Port-base QoS 

• Supports Port Trunking 

• Supports Port Mirroring 

• Supports Port-setting for Speed/Disable, Flow control 

• Easy configuration via Web Browser 

• Easy setting via Web Management Utility 

• Standard 19” Rack-mount size 
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3 Unpacking and Installation 
This chapter provides unpacking and installation information for the Switch. 

3.1 Unpacking 
Open the box and carefully unpacks its contents.  The box should contain the following items: 

• One freeConnect Smart G2400 

• One AC power cord, suitable for your area’s electrical power connections 

• Four rubber feet to be used for shock cushioning 

• Screws and two mounting brackets 

• CD-ROM with Web Management Utility and User’s Guide 

If any item is found missing or damaged, please contact your local reseller for replacement. 

3.2 Installation 
The site where you install the hub stack may greatly affect its performance.  When installing the unit, 
consider the following pointers: 

• Install the Switch in a fairly cool and dry place. See Technical Specifications for the acceptable 
temperature and humidity operating ranges. 

• Install the Switch in a site free from strong electromagnetic field generators (such as motors), 
vibration, dust, and direct exposure to sunlight. 

• Leave at least 4” (10cm) of space at the front and rear of the Switch for ventilation. 

• Install the Switch on a sturdy, level surface that can support its weight, or in an EIA standard-size 
equipment rack. For information on rack installation, see the next section, Rack Mounting. 

• When installing the Switch on a level surface, attach the rubber feet to the bottom of each device 
(Figure 1). The rubber feet cushion the Switch and protect the case and surface from scratching. 

 
Figure 1: Attach the feet to the Switch 

3.3 Rack Mounting 
The Switch can be mounted in an EIA standard-size, 19-inch rack, which can be placed in a wiring 
closet with other equipment.  Attach the mounting brackets to the switch’s front panel (one on each 
side), and secure them with the screws provided (Figure 2). 
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Figure 2: Attach the brackets to the Switch 

Then, use the screws provided with the rack to mount each switch in the rack (Figure 3). 

 
Figure 3: Mount the Switch in the rack 

 

3.4 Connecting Network Cable 
The Switch supports 1000Mbs Gigabit Ethernet that runs in Auto-negotiation mode and 10Mbps 
Ethernet or 100Mbps Fast Ethernet that runs both in half and full duplex mode and 1000Mbps Gigabit 
Ethernet runs in full duplex mode using four pair of Category 5 Cable (Category 5e Cable or better is 
required for Gigabit Ethernet). 

These RJ-45 ports support Auto-MDIX meaning that the Switch can automatically switch between 
MDI-II and MDI-X types, allowing you to use any cable without worrying about whether it is a straight-
through or crossover RJ-45 cable. 

3.5 AC Power 
The Switch uses an AC power supply operating at 100-240V AC, 50-60 Hz. The power switch is 
located at the rear of the unit adjacent to the AC power connector and the system fan. The switch’s 
power supply will adjust to the local power source automatically and the unit can be turned on any 
number of Ethernet cable connected to it. 
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4 Identifying External Components 
This chapter describes the front panel, rear panel, and LED indicators of the Switch. 

4.1 Front Panel 
The figure below (Figure 4) shows the front panels of the Switch. 

 

 
   Figure 4: Front panel of the Switch 

LED Indicator: 
Comprehensive LED indicators display the status of the switch and the network (see the LED 
Indicators section below). 

Gigabit Ethernet Ports (Port 1~24): 
The Switch is equipped with two Gigabit copper ports which support auto negotiating 
10/100/1000Mbps and auto MDI/MDIX crossover detection. The support for automatic MDI/MDIX 
crossover detection provides true “plug and play” capability, you just need to plug the network cable 
into the Switch and don’t need to worry if the end node is a computer, switch, or other network device.  
These two ports can operate in half-duplex mode for 10/100Mbps and full-duplex mode for 
10/100/1000Mbps. 

4.2 Rear Panel 
 

 
Figure 5: Rear panel of the Switch 

AC Power Connector: 
This is a three-pronged connector that supports the power cord. Plug in the female connector of the 
provided power cord into this connector, and the male into a power outlet. Supported input voltage 
range is 100-240V AC at 50-60Hz. 

Reset: 
The Reset button is used to reset all of the settings back to the factory default. 

Note: Be sure that you record the settings of your Switch before performing a reset, as 
all settings will be erased after pressing the “Reset” button. 
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5 Understanding LED Indicators 
The front panel LEDs provides instant status feedback and helps monitor and troubleshoot when 
needed (Figure 6). 

 
Figure 6: LED indicators of the Switch 

5.1 Power and System LEDs 

Power: Power Indicator 
On: The Switch is receiving power. 

Off: The Switch is not receiving power or the power cord has an improper connection.  

System: CPU Indicator 
Flashing: The CPU is working. 

On: The CPU is idling. 

Off: The unit is off. 

5.2 Ports 1~24 Status LEDs 

Link/ACT: Link/Activity 
On: The port is successfully connected to an Ethernet network. 

Flashing: The port is transmitting or receiving data. 

Off: The port is disconnected. 

1000Mbps 
On: The port is connected to a gigabit Ethernet connection. 

Off: The port is connected to a 10Mbps or 100Mbps Ethernet connection or is disconnected. 

100Mbps 
On: The port is connected to a 100Mbps Ethernet connection. 

Off: The port is connected to a 10Mbps or 1000Mbps Ethernet connection or is disconnected. 
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6 Configuration 
You can configure features such as VLANs, trunking, and QoS using the Switch’s web interface. 

With the provided Web Management Utility, you can easily discover all the Web Smart Switches on 
your network, assign IP addresses to them, change the admin password, and upgrade the firmware. 

6.1 Installing the Web Management Utility 
The following gives instructions guiding you through the installation of the Web Management utility. 

1. Insert the Utility CD in the CD-ROM Drive. 

1. From the Start Menu on the Windows desktop, choose “Run…” 

2. In the “Run…” dialog box, type D:\setup.exe (Where “D:\” is the drive letter of your CD-ROM drive) 
and click “OK”. 

3. Follow the on-screen instructions to install the utility. 

4. Upon completion, go to Program Files  Web Management_Utility and run the Web Management 
Utility. (Figure 7.) 

 
Figure 7: Web Management Utility 

The Web Management Utility is divided into four parts: Discovery List, Monitor List, Device Setting 
and Toolbar.  The sections below provide details for each section. 

6.2 Discovery List 
This window displays the list of recognized Web Smart switches that are connected to the network. 

Click the “Discovery” button to begin searching for Switches on the network.  This process may take 
some time, depending on your network configuration. 

Once the Switches have been discovered, double-click on an entry, or select a switch and click the 
“Add to monitor list” button to move a Switch from the Discovery List to the Monitor List. 

Column Heading Definitions: 

• MAC Address: The Switch’s MAC Address. 

• IP Address: The current IP address of the device. 
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• Protocol version: The version of the Utility protocol. 

• Product Name: The Switch’s product name. 

• System Name: The appointed device system name. 

• Location: Where the device is located. 

• Trap IP: The IP where Traps are to be sent. 

• Subnet Mask: The Subnet Mask of the device. 

• Gateway: The Gateway of the device. 

6.3 Monitor List 
To monitor a Switch, it needs to be added to the Monitor List.  You will be able to manage and view 
trap events for the Switches in this list. 

System word definitions in the Monitor List: 

• S: The status of the Switch; an icon ( ) before the switch name indicates that the switch is off or 
not accessible. 

• IP Address: The current IP address of the device. 

• MAC Address: The Switch’s MAC Address. 

• Protocol version: The version of the Utility protocol. 

• Product Name: The Switch’s product name. 

• System Name: The appointed device system name. 

• Location: Where the device is located. 

• Trap IP: The IP where Traps are to be sent. 

• Subnet Mask: The Subnet Mask of the device. 

• Gateway: The Gateway of the device. 
 
View Trap: The View Trap function allows you to view events that occur on the Switch. 

The icon beside the “View Trap” button indicates if there is a new trap that has not been viewed yet.  
When the icon is green, there are no new traps available.  When the icon is red, there are new traps 
waiting to be viewed (Figure 8). 

 

 
Figure 8: Trap Indicator 

When the “View Trap” button is clicked, a Trap Information window will appear showing the trap 
information including the Time, Device IP and the Event that occurred (Figure 9). 

The symbol “ ” represents traps that have not been viewed yet.  This symbol will disappear after you 
review and click on the event record. 
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  Figure 9: Trap Information 

Note: In order to receive Trap information, the Switch has to be configured with the 
proper Trap IP and Trap Events in the Web browser, which are available in the Trap 
Setting Menu.  Refer to the appropriate section for details. 

Add Item: Allows you to add a Switch to the Monitor List manually by entering the IP Address of the 
device that you want to monitor.  

Delete Item: Allows you to delete the Switch from the Monitor List. 

6.4 Device Setting 
You can configure the Switch by using the buttons in the Device Setting section at the bottom of the 
window. 

Configuration Setting: From this window, you can set the IP Address, Subnet Mask, Gateway, Set 
Trap to (Trap IP Address), System Name and Location of the Switch. 

Select the device in the Discovery list or Monitor List and click “Configuration Setting”.  The 
Configuration Setting window will open (Figure 10).  After making the desired changes, you enter the 
password for the Switch and click “Set” to save the changes to the Switch. 

 
Figure 10: Configuration Setting Window 

Password Change: This option allows you to change the password for the Switch.  After clicking the 
button to open the Change Password Window (Figure 11), enter the new password in both the “New 
password” field and “Confirm password” field.  You also have to enter the current password for the 
Switch in the “Original password” field.  Click “Set” to save the changes. 
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Figure 11: Password Change 

Firmware Upgrade: If a new firmware becomes available, use this option to perform a firmware 
upgrade on the device (Figure 12).  You will need to enter the location of the file on the local computer, 
as well as the password for the Switch in order to perform an upgrade.  Warning: Do not turn off the 
Switch or the computer while a firmware upgrade is in process, it may result in corruption of the 
firmware on the Switch. 

 
Figure 12: Firmware Upgrade 

Web Access: Double click on a Switch in the Monitor List, or select a device in the Monitor List and 
click the “Web Access” button to open its web interface in a web browser window. 

6.5 Toolbar 
The toolbar in the Web Management Utility has four main tabs: File, View, Options and Help. 

In the “File” tab, there are Monitor Save, Monitor Save As, Monitor Load and Exit. 

• Monitor Save: Saves the current Monitor List as the default.  The next time the Web Management 
Utility is run, the default list will be loaded automatically. 

• Monitor Save As: Saves the current Monitor List as a file on the local computer at the specified 
filename and file path.  This file can be loaded in the future to retrieve the list. 

• Monitor Load: Load a previously saved Monitor List (using the “Monitor Save As” option). 

• Exit: Exit the Web Management Utility. 

The “View” tab allows you to view and clear the event trap logs for the Switch. 

• View Log: To show the event of the Web Management Utility and the device. 

• Clear Log: Clears the event trap log. 

In the “Option” tab, the Refresh Time function allows you to set how often the utility will update the 
information displayed. Available options are: 15 secs, 30 secs, 1 min, 2 min, 5 min. 

In the “Help” tab, the About option displays the current version of the Web Management Utility. 

6.6 Configuring the Switch 
The freeConnect Smart G2400 has a web interface to allow for easy configuration of the Switch.  A 
network administrator can manage and monitor the switch from anywhere on the LAN. This section 
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describes how to configure the Switch’s advanced functions, including: 

• Port setting (Speed/Disable, Duplex mode, Flow Control and Port base QoS) 

• Virtual LAN Group setting (VLAN) 

• Trunking 

• Port Mirroring 

• System Setting 

• Device status 

6.7 Login 
Before you access the web interface, note that you must be connected to the Switch via a network 
connection, and your computer must be on the same IP subnet as the switch.  For example, since the 
default network address of the default IP address of the Web Smart Switch is 192.168.0.1, then the 
manager PC should be set at 192.168.0.x (where x is a number between 2 and 254), with a subnet 
mask of 255.255.255.0. 

1. Open your web browser (Internet Explorer 5.0 or higher is recommended). 

2. Enter the IP address of the Switch in the “Address” field (Figure 13).  The default is 
http://192.168.0.1. 

 
Figure 13: Entering the IP Address 

When the “Login” page appears (Figure 14), enter the password (the default is "admin") and click 
“Login” to log into the Switch. 

 
Figure 14: Login Screen 

Once logged in, the main menu will be displayed along with a screen showing the status of the device 
(Figure 15). 
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 Figure 15: Device Status 
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6.8 Main Menu 
The main menu on the left side of the screen (Figure 16) has the following options: Port Settings, 
VLAN Settings, Trunk Setting, Mirror Setting, Device Status, Statistic, System Settings, Trap Setting, 
Password Setting, Backup Setting, Reset Setting.  Click on the item that you want to configure to open 
the respective window.  The sections below provide details for each option. 

 
Figure 16: Setup menu 

6.9 Configuring Setup Setting 
There are four items in the Setup Menu: Port Settings, VLAN Settings, Trunk Settings, Mirror 
Settings. 

6.9.1 Port Settings 
The Port Setting page (Figure 17) displays the status of the ports.  Click on a port number to change 
the settings (Speed, Flow Control, QoS Priority, Link Status) for that port. When you need to refresh 
the information on the page, press the “Refresh” button.  

The Link Status column shows the speed and duplex of the port, or “Down” if the port is 
disconnected. 
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Figure 17: Port Setting Page 

After clicking on a port number, the screen below (Figure 18) will open, allowing you to set the 
Speed/Disable, Flow Control and QoS settings of the port. 

 
Figure 18: Port Configuration 

Speed/Disable: 
This setting has six modes: 100M Full, 100M Half, 10M Full, 10M Half, Auto, Disable.  The first four 
allow you to manually set the speed and duplex, Auto sets the port to detect the connection type 
automatically, and Disable shuts down the port. 

Flow Control: 
This setting determines whether or not the Switch will handle flow control. Select Enable to avoid data 
transfer overflows. Select Disable to turn off flow control. 

When the port is set to forced mode, the flow control will automatically be set to Disable. 

QoS (Quality of Service): 
This setting changes the priority of the port.  Connections which are more important (e.g. voice and 
video applications) should be set to a higher priority so the packets on these ports are transmitted first, 
reducing latency. 
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6.9.2 VLAN Settings (Virtual Local Area Network) 
A VLAN is a group of ports which act as a small “virtual” network of their own, independent of the other 
ports. This means that the broadcast domain is restricted to the computers within a VLAN, and 
computers connected to different VLANs are unable to communicate with each other.   The VLAN 
Setting page displays the current VLANs on the switch (Figure 19). 

  
 

Figure 19: VLAN Setting Page 

To create a new VLAN group, click the “Add Group” button to open the new VLAN configuration 
window (Figure 20).  Enter a description for the VLAN, and select the ports to include in the VLAN.  
Click “Apply” button to save the new VLAN. 

To modify a VLAN, click on its ID number.  In the new window, make the required modifications and 
click “Apply”. 

To delete a VLAN, click “Delete Group” to open a window which allows you to select a VLAN to 
delete. 

 
Figure 20: Creating a VLAN 

6.9.3 Trunk Setting 
The Trunk Setting page (Figure 21) allows you to create port trunks.  Up to twelve ports can be part of 
the trunk, resulting in 24 Gbps of bandwidth in full duplex mode. 

Note:  Trunking will only work if the ports are connected to similarly trunked ports on 
another Switch.  There are three groups of ports that can be trunked together. 
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Group 1: Ports 1, 2, 3, 4 

Group 2: Ports 9, 10, 11, 12 

Group 3: Ports 17, 18, 19, 20 
For each group, you can select either to disable trunking, trunk only the first two ports in the group, or 
trunk all four ports in the group. 

 
Figure 21: Trunk Setting Page 

If using VLANs, ensure that the ports being trunked together are in the same VLAN group. 

6.9.4 Mirror Setting 
Port Mirroring duplicates incoming and/or outgoing packets from one port to another port allowing a 
network administrator to analyze the traffic on the network and make any necessary adjustments. 

Configure port mirroring by assigning a source port from which to copy all packets and a sniffer port 
where those packets will be sent (Figure 22). 

Sniffer Mode: “Tx” (transmit) mode will duplicate the data transmitted from the source port and 
forward it to the sniifer port.  “Rx” (receive) mode will duplicate the data received from the source port 
and forward it to the sniffer port.  “Both” will duplicate all traffic to the sniffer port. 

 
 

Figure 22: Mirror Setting Page 

6.10 Maintenance Settings 
There are six items in the Maintenance Menu: Status, System, Trap, Password, Backup Setting, 
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Restore Setting. 

6.10.1 Device Status 
The Device Status page displays the current status of the device (Figure 23).  The screen shows the 
current System Status, Port Status, VLAN Status, Trunk Status and Mirror Status. 

Click “Refresh” when you need to refresh the information. 
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Figure 23: Device Status Page 

6.10.2 Statistics 
The Statistics Page shows the current packet transmission counters for each port (Figure 24).  
Clicking on a port number will display detailed statistics for the port (Figure 25). 

 
Figure 24: Statistics Page 

Download from Www.Somanuals.com. All Manuals Search And Download.



  

 

 
 

Figure 25: Detailed Port Statistics 

6.10.3 System Setting 
The System Setting page (Figure 26) allows you to change the System Name, Location Name, Login 
Timeout, and the IP Address, Subnet Mask and Gateway of the Switch. Through the Web 
Management Utility, you can differentiate between multiple Switches by using the System Name and 
Location Name. 

The Login Timeout is the amount of idle time the administrator is allowed in the web interface before 
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being logged out automatically for security reasons. 

 
Figure 26: System Setting Page 

6.10.4 Trap Setting 
The Trap Setting page (Figure 27) allows the device to monitor for events on the Switch, and send an 
Event Trap to a computer on the network, which can be viewed and received using the Web 
Management Utility described earlier in the manual.  To enable traps, enter the IP Address of the 
computer that will receive the traps, and select which types of events you want to receive. 

 
Figure 27: Trap Setting Page 

Device Bootup: a trap is sent when the system boots up. 

Illegal Login: a trap is sent when someone is trying to log into the Switch using an incorrect 
password.  The IP address that is attempting to log into the switch is also reported. 
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6.10.5 Set Password 
The Set Password page (Figure 28) allows you to change the administrator password.  Be sure to 
change this from the default immediately to prevent unauthorized access to the Switch.  

If you forget the password, you will need to reset the Switch to factory defaults.  To do this, press the 
“Reset” button on the rear panel of the Switch.  Note that doing this will cause the current settings of 
the Switch including IP Address, VLANs, Port Settings, etc. to be lost. 

 
Figure 28: Set Password Page 

6.10.6 Backup Setting 
The Backup Setting page (Figure 29) allows you to back up the current settings of the Switch to a file 
that can be saved on your computer.  It also allows you to restore the settings to the Switch from a 
backup file.   Click the “Backup” button to generate a backup file, and select a location on your 
computer to save it to.  

To restore a previous backup file to the Switch, you must specify the location of the backup file and 
click the “Restore” button to load the previous settings. 

 
Figure 29: Backup Setting Page 

Note: when restoring a recorded file, the current password will not be erased. 

6.10.7 Reset Setting 
The Factory Reset page (Figure 30) allows you to reset the Switch back to its factory default settings.  
Note that all of the settings of the Switch will be reset, and the IP address of the device will be set to 
default setting of 192.168.0.1. 
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Figure 30: Reset Setting 

6.11 Logout 
Selecting this option will log you of the web interface (Figure 31). 

 
Figure 31: Logout 
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7 Technical Specifications 
General 
Standards IEEE 802.3 10BASE-T Ethernet 

IEEE 802.3u 100BASE-TX Fast Ethernet 
IEEE 802.3ab 1000BASE-T Gigabit Ethernet 
IEEE 802.3x Full Duplex Flow Control 

Protocol CSMA/CD 
Data Transfer Rate Ethernet: 10Mbps (half duplex), 20Mbps (full-duplex) 

Fast Ethernet: 100Mbps (half duplex), 200Mbps (full-duplex) 
Gigabit Ethernet: 2000Mbps (full-duplex) 

Topology Star 
Network Cables 10BASET: 2-pair UTP Cat. 3, 4, 5; up to 100m 

100BASE-TX: 2-pair UTP Cat. 5; up to 100m 
1000BASE-T: 4-pair UTP Cat. 5; up to 100m 

Number of Ports 24 × 10/100/1000Mbps Auto-MDIX RJ-45 ports 
Physical and Environmental 
AC Input 100-240V AC, 50-60 Hz internal universal power Supply 
Power Consumption 35 Watts (Max) 
Temperature Operating: 32°F-104°F (0°C-40°C), Storage: 14°F-158°F (-

10°C - 70° C) 
Humidity Operating: 10% - 90%, Storage: 5% - 90% 
Dimensions (W x D x H) 17.3” x 8.3” x 1.7” (440 x 210 x 44 mm) 
EMI FCC Class A, CE Mark Class A, VCCI Class A 
Safety cUL, CB 

 
Performance 
Transmit Method: Store-and-forward 
Filtering Address Table: 8k entries per device 
Packet 
Filtering/Forwarding Rate 

Ethernet: 10Mbps (half duplex), 20Mbps (full-duplex) 
Fast Ethernet: 100Mbps (half duplex), 200Mbps (full-duplex) 
Gigabit Ethernet: 2000Mbps (full-duplex) 

MAC Address Learning Automatic update 
RAM Buffer 4Mbits per device 
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8 Certifications 

FCC  
This equipment has been tested and found to comply with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions:  

(1) This device may not cause harmful interference  

(2) This device must accept any interference received. Including interference that may cause 
undesired operation.  

CE – Certificate  
This is a Class A product. In a domestic environment, this product may cause radio interference, in 
which case the user may be required to take adequate measures. 

VCCI 
This is a product of VCCI Class A Compliance. 
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